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Warning: Use of this software solution under certain circumstance can invalidate your warranty. 
DISCLAIMER 

Use of this software is at your own risk. Neither the software developer 
nor the website operator will provide any form of guarantee. 

Damages of any kind are the sole responsibility of the end user. 
Changing ECU injection mapping or using maps not legally allowed for your country is forbidden. 

Using this software to change ECU mapping is only for track and off-road use. 
All provided information on the sides of TuneECU have been made in good faith,  

but make no claim to completeness and correctness. 
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This description was created for the Windows version of TuneECU and can be 
applied largely on the Android version. Deviations, please refer to the manual  
for the Android version and the online pages of TuneECU. 
 

 
1 Introduction 
 

TuneECU is software to program, diagnose, and test the Sagem, Keihin, Walbro & Marelli  
engine control units (ECU) that are used by some Aprilia, Triumph, Benelli, KTM & Ducati 
motorcycles. Ducati models are supported only by TuneECU for Android, version 2.2 or 
higher. 

 
All provided information on the sides of TuneECU have been made in good faith,  

but make no claim to completeness and correctness. 

Models 
TuneECU use only on these models. 

Date of  
information 

Triumph Daytona 675, only up to VIN # 564947  August 2014

Triumph Daytona 675, from VIN # 564948 / *Bluetooth connection only with TuneECU for Android.  August 2014

Triumph Street Triple & Street Triple R, only up to VIN # 560476 August 2014

Triumph Street Triple & Street Triple R, from VIN # 560477 / *Bluetooth connection only with TuneECU for Android. August 2014

Triumph Speed Triple models 885, 955, 1050 & 1050 R (including models 2014) August 2014

Triumph Tiger models 800/800XC, 885 (900), 955, 1050 & Tiger Sport
(including models 2014) 

August 2014 

Tiger Explorer *Bluetooth connection only with TuneECU for Android. August 2014

Triumph 955 Sprint ST/RS models and 1050 Sprint ST/GT  (including models 2013) August 2014

Triumph Daytona models T595/955i Daytona (all models) August 2014

Triumph Rocket III  (including models 2014)  August 2014

Triumph Daytona 600, 650, Speed Four, TT600 (all models) August 2014

Triumph 2 Cyl. EFI Models Thunderbird Big Bore(1600 & 1700 cc), except Commander and LT
America, Bonneville, Scrambler, Speedmaster, Thruxton (including models 2014) 

August 2014 

KTM 990 LC8 & 1190 RC8 (including models 2012) 
KTM 690 Duke  (including models 2011) (except all Duke 4 models)  
KTM 690 SMC & Enduro/690 Supermoto (including models 2013) 

August 2014 

Aprilia models Caponord and Futura RST  August 2014

Benelli Tornado, TNT & TREK models
(TNT & TREK models are only supported by TuneECU for Windows) 

August 2014 

Ducati 848, 1098, 1198, Hypermotard 1100, Monster S2R 800 / 1000 (ECU 5AM)
Ducati models are supported only by TuneECU for Android, version 2.2 or higher. 

Februar 2015 

* With Bluetooth connection, the functions for reading and flashing of maps, are disabled in TuneECU. 
 

The manual, software and mapping files and other useful information are available here:  
•  http://www.box.net/shared/pusg6v7nyd  
•  http://www.tuneecu.com   
•  The Android version of TuneECU is available on the Play Store Google. 

 
 

TuneECU for Windows is FREE 
 It can be given only FREELY 
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2 Installation                                                                                                                                                   
 
2.1 Required configuration  
 PC (Netbook, laptop, desktop) running Windows XP, Vista, Win7 or Win8/8.1 (32 or 64 bit) except Windows8/8.1 RT;  
                minimum screen resolution 1024x576  
 NET Frameworks 2.0 or greater USB/OBD cable with FTDI chipset and the driver FTDI D2XX CDM Driver:  
                PLEASE REFER TO www.tuneecu.com for the proper current driver to use.  
                For Aprilia,  KTM &  Benelli  ECU's, additional components are required,  please refer to www.tuneecu.com 

For Walbro ECU:  
                only a serial cable RS232, a serial port on the computer, and AMP-Super-Seal-connector-6pin is required. Maybe you need nor a  
                USB/RS232-converter. This converter is required if your computer has no serial interface (RS232) has. Please refer to www.tuneecu.com 
 
2.2 Installing NET FrameWorks 2.0 (XP only). 
NET Frameworks 2.0 http://www.microsoft.com/en-us/download/details.aspx?id=1639 Execute dotnetfx.exe and follow the instructions.  
 

2.3 Installing the Windows drivers  
 
Windows 7/8/8.1 and Vista users: MAKE SURE YOU ARE NOT connected to the internet. Disconnect any WIFI or Ethernet cable.   
Otherwise Windows will download the latest driver automatically, which may not be compatible with TuneECU.  
Download the FTDI driver only of the TuneECU site. For safety, you waive on the version 2-12-00. 
With the FTDI driver version 2.12.00, the chips of cheap cables that have fake FTDI chips, made unusable by the current driver. 
Never allow Windows to install the driver, and disconnect the Internet connection before the first plugging of the cable. Use then 
always the same USB port. 

  

Driver’s limitation for the USB‐TuneBoy‐cable:      
The TuneBoy cable works only with the ancient FTDI driver from TuneBoy's own site. The hardware id of TuneBoy cable 
 is different vs. a generic/TuneECU FTDI cable. So even though both cables have same chip, TuneBoy cable needs the 
 matching driver. 

  
 1. Plug the cable into a USB Port.  
 
 2. The PC will open the Found New Hardware Wizard to install the USB/Serial driver:  

 
 3. Choose “No, not this time” for the connection to Windows Update.  
 4. Click Next. You see this screen:  

 
 5. Under the checkbox for "Include this location in the search… ", select the path where you have downloaded and saved the drivers.  
 6. Click Next.  
 7. The USB driver is installed. Click Finish when complete.  
 8. Repeat the above steps for the serial driver.  
 
Driver Installation of USB/RS232 converter, required if your computer has no serial interface (RS232) has (Benelli Walbro models). 
Use the drivers that came with the cable. 
 
Problems with the driver installation? 
For example, Windows reports: cannot find driver software for this device please read this post:   http://www.triumphrat.net/2155147-post685.html 
Another source for help is the FTDI-support. 
If you have any problems with the installation of the FTDI driver, please use the support of FTDI under 
http://www.ftdichip.com/Support/Documents/InstallGuides.htm, there are support documents, the selection of documents must correspond your used  
operating system. 



TuneECU 2.5                                                                                    4/ 17                                                            Feb-21-15 

   

 
© 2009-2015 Alain Fontaine 

2.4 Installing TuneECU for Windows 
  
 1. Download TuneECU from TuneECU.com and extract the ZIP file.  
  
 2. Copy TuneECU.exe and TuneLibrary.dll into a directory on your hard drive. For example C:\TuneECU.  
 
 3. Download the appropriate (.hex) map files for your bike from TuneECU.com.  
 
3 Using the Software 
 
3.1 Languages  

 

3.2 Connecting 

 

 
 
 
 
 
Connection to the Walbro ECU: 
- Connect the serial cable with the diagnostic socket of the bike,  TuneECU start. 
- Select the assigned COM port  in the menu "Options-serial-interface" 
  the software must still be offline at this time, not connected with the bike, auto-connection  
  must be menu "Options" deselected). 
- Turn on the ignition 
- Now select the menu "ECU" <Connect> 

 
3.3 Manually connecting to the ECU  

 

3.4 Selecting a Mode  
TuneECU has 3 modes:  
 

 

 
 

4 Diagnostics 
 
                               Triumph                                                                                                                    Aprilia  

          

                                                

The software is available in French, English, German, Italian, 
Portuguese and Spanish.  
The default language is set based on your windows system language. 
You can change it using the Language submenu under Options. 

For Sagem & Keihin models: 
Connect the USB/OBD cable to the ECU connector on the motorcycle, and the USB side to the 
computer. Turn the key to the ON position and the ignition kill switch to the RUN position, but do not 
start the engine. Start TuneECU and wait for the connection to be established. You can monitor the 
connection with the indicator at the bottom-right corner of the screen.  
This change from red to flashing orange and then flashing green. 

 Red – not connected  
 Orange – connecting  
 Green – connected  

If the connection to the ECU is not automatic, 
select Connect from the ECU menu.  

 Map Edit: Editing and programming ECU maps  
 Diagnostics: Checking the sensors for engine management  
 Tests: Adjustment and testing of certain component of the motorcycle  

 
The mode selection is done by clicking the proper button  
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KTM        Benelli  

        

4.1.1 Dashboard  
This screen will have a slightly different presentation between Sagem and Keihin ECUs.  
The analog gauge displays the following indicators.  
(Note, not all sensors are available on all bikes.)  
 
 

 Cooling fan On/Off 
 

 
Malfunction in the MIL system  
(EFI light on Caponord/Futura)  

 

 
Fall-over sensor  

 

 
Neutral (N) & Side stand (S) 

 

 
Button "Power Control" (Benelli 1130) 

 
Speed indicator  

 

 
Engaged gear number 

 

 
Engine RPM  

 

 
 

 
3 dial (Analogue/Digital)  
 

Throttle position sensor in % 
 

MAP (manifold air pressure) 
in hPa (Keihin) 

Ignition advance (Sagem) 
 

Keihin Sagem 

Engine temperature in °C. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



TuneECU 2.5                                                                                    6/ 17                                                            Feb-21-15 

   

© 2009-2015 Alain Fontaine 

4.1.2 Sensors                                                                                                             
The values, state, or voltage (V) of all other sensors are listed on the left side of the display. Move your mouse over the value and a 
highlighted text will give you a definition of the value.  

Triumph KTM Aprilia Benelli 

 
 
Note:  

To hide a sensor display, click the – sign . The icon will become a +. Click the + to re-enable the sensor readings.  
The display will refresh faster when fewer sensors are displayed.  
 

4.1.3 Error Codes  
 

 
Lists the error code(s) currently stored in the ECU and a short description of each.  
 
4.1.4 Status Bar  
The status bar at the bottom of the screen shows some general information.  
 

Battery Voltage  
Note: At least on Caponord/Futura, the displayed voltage is about 0.5v 
more than at the battery. This difference is also present on other 
tuning software.  

 

 

O2 Sensor (Closed or Open Loop)  
If the bike has an O2 Sensor, this icon will show if the system is 
operating in closed-loop or open-loop mode.  

 

   

TPS (Throttle Position Sensor)  
 

Connection Status (Red-Orange-Green) 
 

Name of the open map (Tune) 
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5 Tests & Adjustments 

 

5.1.1 Keihin Mode 

In this mode, only 3 small dials of the dashboard are active, providing the value of the vacuum 
intake (Manifold Absolute Pressure) of the corresponding cylinder (Keihin only), thus providing 
reference values for synchronizing butterfly valve (throttle) opening.  

 

 
*** Warning: the metal body of the spark plug must be earthed/grounded to the bike otherwise the coil may be destroyed. 

 
 

Test Description Triumph KTM Aprilia 
Benelli
Sagem 

 
Turn on sequentially all lights, engine temperature chart, speed to 100km/h, 
tachometer to 7500rpm  

 

Keihin 

Yes 
 Only 
Tacho 

To 
7500 
rpm 

Yes 
 Only 
Tacho 

To 5000 
rpm 

No 

 Starts the cooling fan – listen for the fan noise  
 

Yes No Yes Yes 

 Prime the fuel pump – listen for the fuel pump noise  
 

Yes Yes Yes Yes 

 Cycle through the idle stepper – listen for a very quiet ticking noise  
 

Yes Yes Yes Yes 

 
(Only bikes with charcoal canister)  
Activate the purge valve – listen for a very quiet noise  

 

Yes Yes Yes No 

 Secondary air injection system  
 

Yes Yes No No 

  O2 probe heater - see in Diagnostics No Yes No No 

 Air flap (675 Daytona) located in the air intake towards the front  
 

Yes No No No 

 Exhaust valve (675 Daytona) located in the exhaust  
 

Yes No No No 

 Adjust the exhaust valve – when you change the cable  
 

Yes No No No 

/TPS 
Keihin (except KTM) It is done in several steps. Read the workshop manual. 
The third dial shows the voltage (V), allowing the adjustment of the position and 
adjustment of the controller. 

 

Keihin No No No 

 
See the procedure in the “Resetting the Throttle Position Sensor (TPS)” section 
for Keihin. 

 

Keihin No No ? 

 
Excitation of the coils -- hear or see if sparks will appear at the 
spark plugs. *** 

 

No Yes No No 

    Several triggers ---- hear the function No Yes No No 

 Test the 2nd throttle function only  (Triumph Rocket & KTM ) 
 

Yes Yes No No 

 
Sagem: Recalibrate the throttle position sensor, Double-click the Reset TPS 
button 

 

Sagem No Yes Yes 

 Adjust the idle fuel trim (Triumph without O²-Sensor only) 
 

Sagem No Yes Yes 

Adjust IACV (Stepper 
Motor) 

Triumph Sagem Double-click to IACV. 
It is possible to reset these two last parameters by right-clicking the arrows active 
during the adjustment. 

Sagem No Yes ? 

Long Term Fuel Trim Adjust the long term fuel trim (Sagem) Triumph models with O²-Sensor only Sagem No Yes No 

Adjusting the throttle cable 

The idle speed control stepper motor will be completely retracted and the throttle 
valves completely closed. 
Switch the ignition switch off, WITHOUT exiting or disconnecting the software, and 
adjust the throttle cable clearance.

No Yes No No 

 5.1.2 Tests Not all tests are available on all motorcycles. Test components of the motorcycle. Each test lasts around 10 seconds:  
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5.1.3 Adjustments (Keihin except KTM) 
  
Adjust the exhaust valve: Refer to the workshop manual. The third dial displays the position of the valve in % during this adjustment.  
 

Reinitialisation of the idle stepper motor: It is done in three steps. Read the workshop manual. The third dial shows the voltage (V), 
allowing the adjustment of the position and adjustment of the controller.  
 
Reset Adaption (Reset TPS): See the procedure in the “Resetting the Throttle Position Sensor (TPS)” section. 
 

KTM only 
Adjusting the throttle cable: The idle speed control stepper motor will be completely retracted and the throttle valves completely closed. Switch the 
ignition switch off, WITHOUT exiting or disconnecting the software and adjust the throttle cable clearance.  
  
5.1.4 Adjustments (Sagem) 
Reset TPS: Recalibrates the closed throttle position to a zero reading. After the reset, restart the engine and idle for at least 30 
seconds.  
 

Idle Fuel (CO): Double-click to access this adjustment. Allows adjustment of the fuel trim at idle.  
 

Long Term Fuel Trim: Double-click to adjust the parameter.  
 

Adjust Stepper Motor: Double-click to adjust the position of the idle stepper motor.  
 

It is possible to reset these two last parameters by right-clicking the arrows active during the adjustment.  
 
5.1.5 Walbro ECU settings (Benelli TNT, Tornado 1130 & TREK) 
- Reset TPS: resets the closed position of the throttle. 
- Idle Fuel Trim (CO): (double click on the line to access this setting) lets you adjust the fuel richness at idle. 
- Global.Injection correction: Double click on "Global.Inj.correction" and adjust the parameters. 
  (Recording in the ECU will be effective only after the value turns gray. 
 

6 Maps 
(Not available in the Lite Version.)  
 
Fuel/Ignition maps of file type “.hex” are generated by reading the ECU, and available on the website (www.tuneecu.com).  
You must select a map that corresponds to your model of motorcycle and its configuration (type of exhaust for example).  
From the Display menu, choose Map Infos to see comments and the basis of the map (in parentheses).  
 

 
              

 

6.1 Selecting a Map  

 

 

 

 
 
 
6.2 ECU Information  

 

 

From the File menu, select Open Map File. The map’s data appears in a grid.  

 
 

Serial number  
Map ID  
Checksum and a counter how many times the ECU was reprogrammed.  

Click in this field to see information from the second ECU (KTM 690).  
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6.3 Map Tables  
F1  
F2 
F3 
F4 
Fuel Trim 
L1 
L2 
L3 
L4 
I1 
I2 
I3 
I4 
Ignition Trim 
 
A/F Table 
 
Idle 
 
Exhaust Valve 
 
Second Throttle 
 
F‐L Table 

 

F1 – F4: main fuel table for cylinder 1 to 4 / RPM & butterfly opening or F3-1 corresponding to the position of the 
mapping switch on the KTM 690.    For Benelli models, see below under this box..                 
 
  
Fuel Trim: Adjustment for the Fuel table F (in %), or Right click on a F table if not visible. 
 
L1-4: Fuel table for the small butterfly opening / RPMs & air pressure  or L3-1 for KTM690 
 
 
 
I: Ignition advance table I3-1 and I LOF (Low Octane Fuel) for KTM690 
I-Tables Daytona 675, at these model, are the I-tables depending on the selected gear. 
I (1st) = 1. Gear, I (2 - 5th) = 2. - 5. Gear, I (6th) = 6. Gear and I (N) = Neutral 
For Benelli models, see below under this box. 
 

Correction tables "Ignition advance I (°) or right-click on a table if I is not visible, e.g. KTM 690 
 
Air/fuel                   Air/fuel ratio (AFR)  
 
 
Idle                        Engine Idle by temperature  
 
Exhaust Valve      (Daytona 675) Position of the exhaust valve / RPM.  
 
 
Butterflies             (Rocket III &amp; KTM) Position of the secondary butterflies 
  
 
Transition F – L     F to L transition and inversely / RPM and throttle opening  

 

 

For Benelli models: TnT Sports, TNT CR, TreK1130, TnT standard (05/06) and TNT R160.  
For the models, TnT Sport, TnT CR, and TnT TreK1130 standard (05/06), Map1 (I & F) the maps is for  
reduced fuel consumption = reduced performance. Map0 (I &F) is for open performance and maximum torque. 
For the TNT R160, Map1 (I&F) is for use with DB-killer, and Map0 the map is for operating WITHOUT DB-Killer, Map0 (I&F) is not 
suitable for use with DB killer. (Source http://www.benelli-info.de) 
 

6.4 Map Parameters  
Not all parameters are available on all bikes.  

 

 
RPM rev limiter, temperature trigger (fan), Road speed reading correction  (range of 0%  to -6% 
correction), Limiting speed (Rocket III), Air Flap &  Exhaust Valve Daytona 675, cutoff time Quick 
Shifter (Daytona675 from model 2009), injector flow rate and A / F target (Sagem). 
The status bar displays the battery voltage, condition of the injection system (operating in closed 
or open loop), adaptation state for the TPS (Keihin), storage drive location and filename of the 
loaded map. 
The parameters for the two Benelli 1130 Map's (Map 0 and Map 1) can be changed separately, 
select the table 0 or 1 (F or I), so you can access to the appropriate parameters. The display 
"parameter" changes to automatically depending on the chosen F or I map, "parameter (Map 0)" 
or "parameter (Map1)". 

 

 

NOTE: Unlike some other tuning software, TuneECU lets you only change one value for Rev Limit and Thermo Fan. That is, you 
cannot specify both ends of an on/off range for these settings. The range is fixed, but you can adjust the trigger point, changing the 
RPM or temperature at which the fixed range of values applies.  
 

For example:  

Thermo Fan = 106. The fan will come on at 106. It will shut off again at 100. (The range of six degrees cannot be changed,  
but the start point of 106 can be.)  
Similarly, the RevLimit setting has accompanying on/off parameters that cannot be changed, although the main limit setting can.  

 Rev Limit = 10,000 RPM 
 Restart Normal Fuel -50 RPM = 9950 RPM  
 Increase Fuel Cut +100 RPM = 10,100 RPM  
 Kill All Fuel +200 RPM = 10,200 RPM  

 

6.5 Reading Maps  
For a Keihin ECU, this operation may take 20 minutes. You must remove the headlight fuse to prevent the discharge of the 
battery. Your battery must be fully charged before doing any mapping work -- ideally connected to a battery tender.  
You must have a map loaded from a .hex file for TuneECU to allow you to read a map from your ECU.  
Follow the direction in “Selecting a Map”. KTM 690 on select maps to play (FI or EP).  
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Choose Read Map from the ECU menu.  

 

This reads and displays the map in the ECU. Before doing anything else, save this map.  
 

Be sure to save the map to your hard drive.  
 

Reading time may be significantly reduced if a map with the same base is already open in the program. The base is indicated in 
parentheses.  
 
Reading progress is visible in the status bar in the bottom  

 

The operation can be canceled by clicking on the Close button. The map must be saved in order to reprogram the ECU.  
 
6.6 Changing Values and Settings in a Table (advanced use)  
It is not recommended to change tables of Fuel or Fix F & I. The map is already optimized depending on your basic configuration. 
However, if you have a dynamometer, it is always possible to adjust the values for a better performance of your particular engine. 
Other tables can be modified according to your preferences: idle, valve exhaust, and air/fuel, knowing that better power is obtained with 
an AFR value of 12.8, and lower fuel consumption achieved at 14.7.  
 
6.6.1 Editing Table Values  

 

 

 

6.6.2 Editing Map Parameters and turning on or off from devices 

 

 

Select the value by a single click. Multi select is possible.  
Change the value with the up/down button. Use the arrow keys from the keyboard, 
you can jumping from version 1.8.5 from a single selected cell in the adjacent cell.  
The change can be absolute or in % on the F & L table. F4 key allows to switch 
between modes.  Le value before modification can be display using the F6 key.  

Double-click the desired parameter and change it according to your wishes.  Use the Esc key to  
undo the changes to make. Otherwise, the new values will be automatically used as default values. 
The revised map must be saved in spite of this and can then be uploaded to the ECU. 
 
For turning on or off a device (eg, the SAI) with the left mouse button on the Device make a double-
click or click the device with the right mouse button and select "Enable" or "Disable". 
 
The parameters for the two Benelli 1130 Map's (Map 0 and Map 1) can be changed separately,  
select the table 0 or 1 (F or I), so you can access to the appropriate parameters. 
The display "parameter" changes automatically depending on the chosen F or I map, to "parameter 
(Map 0)" or "parameter (Map1)". 
 
Caution: Do not disable the secondary butterflies (KTM) only if the butterflies or the secondary 
system (motor PAP and second GST (TPS) are removed. 

One or Multiple cell can be copy/pasted, after selection – right click to access the copy/paste menu 

Select the first cell or multi select the value to be pasted and Right click.  
 

Note: The values that have changed in the table, are shown in white color. 
(Version 1.8.5) 
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6.6.3 Modification in graphical mode 

 

Select the rpm curve to modify with a right click on a rpm axis value, then select (or deselect) the TPS points to modify 
with a click on a TPS axis value. The selected points can be now move with the mouse. 
Save the modifications with a right click on an another rpm curve to modify or with the 'Enter' key, press the 'ESC' key to 
quit the modification mode without saving. 

 

You can also modify a TPS curve with a right click on a TPS axis value, then select the rpm point to modify at the bottom 
of the graph. To select or deselect a area of points, click on the first value and shift‐click on the last. 
The F curves can be move in % or absolutes values, the 'F4' key allow you to toggle between this 2 modes. 
By holding the shift key pressed while you move the curve with the mouse (or the wheel), the absolutes values are 
increased (or decreased) by 10. (values multiplied by 1000, eg 4.6 = 4600 rpm) 

6.6.4 Comparing Maps  

 

 

 
 
 
 
 
 

 

From the File menu, select Compare File. 
  
Select a different map for comparison. Pressing the <F6> key to view the values.  
If you press the F6 key again, you return to the current loaded map. 
 
The compared map that was opened to compare the values, you can copy values and then 
paste in the other map (currently loaded map). 
 
To exit the comparison mode, select this menu again and to cancel the selection of the file.  
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6.6.5 Reprogramming the ECU  
Your battery must be fully charged before doing any mapping work -- ideally connected to a battery tender,  
better yet a second 12 volt battery from a car Your laptop must be connected to the power supply.  
 

  or  

Attention! For KTM 690: The FI and EP mapping must match on a KTM 690. 
For the KTM 690 both cards are always required (FI and EP-Map)  

FI is a acronym for EFI    =    Electronic Fuel Injection                        EP is a acronym for EPT =   Electronic Power Throttle 
 

Walbro ECU: follow strictly the instructions on the screen to keep it the 2-pin connector ready and connect this,  
when the program tells you to. 

Verification of compatibility between the ECU and mapping is done. The progress of the download is displayed in the status bar  
(Fig. 11). 
 
At the end of the download, a message is displayed if the transfer completed successfully. 
ATTENTION! Walbro ECU: Remove the 2-pin connector before turning off the ignition. 

 

Download progress is visible in the status bar.  

 

 
 

6.6.5.1 Failure to Download  
 

 

6.6.5.2 Recovering from a Download Failure (Sagem Keihin) 
 

 

 

6.6.5.3 Recovering from a Download Failure (Walbro) 
- Wait for the message "ECU not responding ..." and select  Cancel 
- Select menu "ECU" <Recovery> 
- Always follow the instructions on the screen. 
On the final process, the final message "ECU fully restored" Confirm by clicking "OK" 

At the end of the download, a message confirms that the operation was successful.  

From the ECU menu, select Download. Or click the green Download button.  
This action prompts for confirmation. A verification of compatibility between the ECU 
and the map is done.  

At the end of the download, a message is displayed if the transfer completed 
successfully.  
ATTENTION!! Walbro ECU: Remove the 2-pin connector before turning off the ignition.  

1. Click OK.  
2. Do not disconnect the cable.  
3. Turn off the ignition.  
4. Turn on the ignition.  
5. Wait for TuneECU to connect to the ECU.  
6. If the Download button is green, start the download again. If not, wait for the recovery option to appear. 
Note: For this process, in TuneECU must a suitable map to be open, at the best an OEM map.                

The recovery option should start automatically. If it does not, go to the ECU menu, and select 
Recovery.  
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6.6.6 Importing a PCIII or PC-V Table (PowerCommander 3 or 5) 

 
 

For Sagem User: 
Unfortunately, there is a small problem, TuneECU can probably import "cylinder-selective PC-Files" to a Sagem-map, but from these 
"PC-Files", only the first trim table in the main table (F-table) it is transferred. This means that before importing such a PC file, this 
PC file from "selective cylinder file" to "BASIC file" must be converted. This conversion can be performed with the Power Commander 
software. 
For KTM User: 
TuneECU follows the KTM convention, and commits the Trim 1 to F1 (F1 in TuneECU = rear cylinder). 
PowerCommander not follows the KTM convention, in the cyl. selective PCIII‐ or PC‐V map the table1 
is the front cylinder. You must change the values in the PCIII‐ or PC‐V Map before you import the cyl. selective PCIII  
or PC‐V map with TuneECU. 
 

6.6.7 Saving a Map  
 

 

6.7 Editing Tables  
 

 

 

 

 
6.8 Displaying Maps Graphically  
 
 

 

 

 
 

 

 
<Menu> File-Import PC Table (.djm table or .pvm table): 
Applies *F-corrections* from a PCIII or a PC-V table  in the "F-Trim" table. 
If available the** Ignition table** will be imported into the I Trim table. 
 
    *  includes support of "cylinder Advanced" feature, but not the "Gear  Advanced", in  
       this case you must   choose the "Gear" table to import. 
  **  Only the first Ignition table will be imported. 

From the File menu, select Save Map File
  
The modified map is saved as a .hex Map file. 

When working with map tables, the Edit menu contains these choices for moving blocks of table data among maps:  
 
Copy Table: Copies the table selected in the Clipboard.  
 
Export Table: Exports the selected table to a text file. 
 
Paste Table: Replaces the table selected by the one in the clipboard if the same type. 
  
Use “F Trim” for all F Tables: For all F tables, change in whole tables F or separately.  
 
Commit Trims: Corrects F fuel tables in %, and I ignition tables in °, according to the correction tables F & I, then 
puts zero values.  

To see a graphic representation of the table, select Graphic from the Display menu, or press <F5>. 
F7 key shows the curves representing the values of the table for each opening throttle. 
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6.8.1 Comparing Maps Graphically  
While comparing maps, press <F6> to see the comparison graph, represented with dotted lines  
Press the <F4> to switch to mono or multi curves.  

 

 

6.8.2 Comparing Maps Graphically for a Given RPM  
Click on any RPM to see a comparison between the two maps. Drag the mouse up and down the RPM range to see the display change 
in response.  

 

6.8.3 Comparing Maps Graphically for a Given Throttle Position  
Click on any throttle position to see a comparison between the two maps. Drag the mouse up and down the throttle range to see the 
graph change in response.  

 

7 Viewing Information Logs 
 

 
 

 

8 Viewing History (Sagem) 
 

 
 

Select Logs from the Display menu to see an overview 
of the dialogue between the software and the ECU. 

From the ECU menu, select History.  
You see a windows with the logs of the latest maps loaded into the ECU 
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9 Resetting Adaption (Keihin & Sagem-Lambda models) or Throttle Position Sensor (TPS) Sagem  
 

9.1 Keihin Triumph  
After each download, a “reset Adaption” is needed.  
 1. Turn the ignition off and back on again.  
 2. Wait 10 seconds and turn the ignition off again.  
 3. Turn the ignition on and select Reset Adaption from the ECU menu.  
 

 

Start the engine and let it idle until the TPS light in the status bar becomes green – around 15 to 20 minutes.  
At this process, don't touch the throttle. If the TPS light doesn't turn green after twenty minutes, don't worry and turn the engine off  
anyway as sometimes it doesn't trigger, and in our experience the job is done anyway. 
 

The manufacturer of Triumph motorcycles describes the way of the standard adaptation as follows: 
 

1. Ensure the transmission is in neutral. 
2. Ensure the ECM has no stored faults (DTCs). 
3. WITHOUT TOUCHING THE THROTTLE, start the engine and allow it to warm up to 90°C (60°C on  
    Bonneville, Scrambler, Thruxton, America, and Speedmaster models). 
4. Leave the engine to idle for a further 12 minutes. 
 

Note: 
• If during an adaption cycle the conditions are no longer met, for example if the motorcycle is ridden, the 
motorcycle may not be fully adapted. The adaption process will continue each time the conditions are met 
again, and the engine has idled for longer than 3 seconds. 
 

Following the description for the fast adaptation method with the Triumph Diagnostic Tool: 
 

To start a fast adaption: 
1. Connect the diagnostic tool, select ADJUST TUNE (Map) and select RESET ADAPTIONS.  
    This will force a fast adaption routine to take place in around 5 seconds. For this to happen,  
    the engine must be running, it must be at normal operating temperature and in closed loop control  
    mode. Under any other conditions (such as with the engine not running) fast adaption will not take place 
    and may cause default values to be loaded, which may then require a normal 12 minute adaption routine  
    to be run.  The fast adaptation method is feasible even with TuneECU. 
 

Note: 
• Using the fast adaption method above with the engine off and the ignition on will reset the adaptions to  
   their default (not adapted) factory settings. A full 12 minute adaption routine will then be required. 
• Both methods only adapt the idle area - the off idle area can only be adapted when the motorcycle is 
   ridden under load, i.e. on the road. 
• The off idle adaption area covers cruise sites from 30 to 90 mph (50 to 145 km/h), so the motorcycle must 
   be ridden in this area to adapt. As it is not always possible for dealers to adapt motorcycles in this way, 
   it is not a problem, then the motorcycle will perform continue adapting during normal use. 
 

9.2 KTM  
After downloading a FI-map, start the engine and run at idle (without touching the throttle) for 15 minutes and then the engine turn off. 
990cc models SD, SM, and Adventure: 
The 990s must be on the center stand, and are thus stand vertically. 
For SD / SM models use a Paddock Stands or the side stand with a piece of wood underneath. 
The engine must be cold. 
There should be the coolest possible air temperature outside, this can be very helpful for a lower fuel consumption. 
Start the engine and let it run at idle for 15 minutes. During these 15 minutes, not use the throttle or any other functions. 
The 15 minutes need to be strictly adhered to, and must not fall below. 
The time can only be exceeded by a maximum of one minute. 
Should the engine go out, then re-start ONLY, do not begin 15 minutes again. (Source: KTM Forum) 
 

New in TuneECU version 2.3.5 for KTM 990 & 1190 

Reset ECU after replacing or repairing the engine. 
CAUTION: To adapt the ECU to the change of parameters after replacement or repair with 
the replacement of the engine pistons, cylinders or cylinder heads, a reset of the ECU must be performed. 
If you omit this step, the engine can have a dysfunction at idle for a long period. 
- Connect the diagnostic cable, run the program and turn ignition ON. 
- Wait until connection is established. 
- Go to the tab "Tests" and double-click "Reset Adaptation". 
- Wait for the message "Reset Adaptation done", exit the program and disconnect the diagnostic cable. 
- Run the engine at idle for 15 minutes without touching the throttle, check the coolant temperature, stop the engine in case of overheating. 
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690cc models: 
 

After downloading a FI-map, start the engine and let running it idle (without touching accelerator) for 15 minutes, 
then turn it off. 
After downloading a EP-map, Following a mapping download into the ECU, turn off the ignition (key) , turn on the ignition, slowly 
rotate the Throttle until full throttle then slowly close the throttle, turn off the ignition. 
 

9.3 Reset TPS Aprilia, Benelli & Triumph Sagem models 

 1. In the Test mode, double-click Reset TPS.  
 2. Turn off the ignition.  
 3. Turn on the ignition.  
 4. Start the engine and let it idle for one minute without touching the throttle.  

9.3.1 Reset Adaption Triumph-Sagem-Lambda-models 
The manufacturer of Triumph motorcycles describes this process as follows: 

Fuel System Adaption — e.g. Daytona 955i, Sprint ST, Sprint RS, Tiger, TT600 and Speed Triple 
(only Sagem models with Lambda) 
 The fuel system fitted to the above models is adaptive. This means that the engine management system will self-adjust air fuel ratio 
(i.e. the mixture setting) to its optimum level in order to ensure differing running conditions do not result in poor running. 

During an adaption, the engine management system examines the air--fuel ratio as measured by the oxygen sensor in the exhaust 
system and, if necessary, makes an adjustment. In some cases, a single adaption may be sufficient but in others, more adaptions will 
be necessary. 
 

An adaption take place when all the following conditions are met: 
 

- Gearbox in neutral, clutch engaged. 
- Coolant temperature 80 -- 100 °C 
- Airbox temperature 21°C minimum 
- Engine idling for 10 -- 30 seconds 
 

Once adaption has taken place, the settings are retained ensuring that adaption is not necessary every time the engine is started. 
 

Particularly for new bikes, where the engine has not been run-in, it may be necessary for dealers to ensure adaption has taken place 
before handing the motorcycle over to the customer. This can, of course, apply at any other times as well. 
 

To force adaption to take place, start the engine and warm it up until the above conditions aremet, adaption takes place automatically. 
Blip the throttle every 30 seconds to start another adaption cycle. When coolant or airbox temperatures are above or below adaption 
thresholds, allow the engine to cool or warm-up before continuing. 
To check that adaption has been completed, scroll the Triumph diagnostic tool to DIAGNOSTICS—CURRENT DATA--LAMBDA FUEL. 
in a correctly adapted bike, the lambda fuel reading should show 0.0% (though operators should note that the figure will continue to 
change during engine operation but will settle at 0% briefly but regularly. If reading higher than +3% or --3% are seen continuously, 
adaption is necessary and can be brought about in the conditions mentioned earlier (remembering that more than one adaption will be 
needed on occasions). If a stationary LAMBDA FUEL figure of --19.6% is seen, download the correct tune for the model in question 
and begin the adaption process as described. 
Finally, use of the SET LONG TERM FUEL TRIM adjustment in the Triumph diagnostic tool should be reserved solely for when 
replacement ECMs are newly fitted (or are transferred from another bike). 
 

In clarification, the following described process should be not so correct. 
 

1. Ensure bike is seeing a closed throttle position (CTP) 
2. Bike in Neutral 
3. Coolant temperature between 80-96°C 
4. Minimum air box temperature of 21°C 
5. Now with clutch pulled, blip the throttle to 3000 RPM and let it drop back to idle for at least 30 seconds, all with the clutch lever  
pulled in. 
 

Check bike is adapted by viewing Lambda Fuel. Figures should be "toggling" +4 to -4 
 

Don't forgot to check IACV steps are 20 - 35 
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9.4 Reset TPS Benelli Walbro ECU (TNT, Tornado 1130 and TREK models) 
In testing mode, double-click "Reset TPS" 
 

10 Erasing Error Codes 

 
 

11 Options 
 

11.1 Auto-Connect  

 
 
 

11.2 Interface  
From the Options menu, select Interface to see the interface used to connect to the ECU. Connect only a single interface cable.  
Attention New in version 2.3! Select the correct interface, for Keihin and Sagem select "USB" and for Walbro select  
"Serial"- and then the correct COM port. 
 

12 Exiting the Program 
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The Auto-connect option is found on the Options menu.  
If this option is checked and the cable connected, the program automatically connects to ECU. 
 By default, the auto-connect setting is enabled  

To close TuneECU, select Exit from the File menu.  
This action is not possible if a download is in progress. 
 

You can clear stored error codes from the ECU by choosing Erase Error Codes from the ECU menu while in 
Diagnostics or Tests modes. The issues that caused these codes must have been corrected, or the error 
code will reappear.  

http://www.tomhamburg.net/Kontakt_Tom.html
http://www.tomhamburg.net/Kontakt_Alain.html



